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Chapter 1

XES

1.1 XES v1.31

The XDME Excelsior Suite
by
Fergus Duniho
Copyright © 1994 Fergus Duniho
Please note that this guide is under construction.
Some links go nowhere.

Introduction
Requirements
Installation
Features

Editing

Special Features
History
Copyright
Distributability
Disclaimer

About the Author

1.2 Introduction

XES is an integrated suite of macros, menus, keymappings, programs,
requesters, and ARexx scripts for XDME. XDME is a powerful and
configurable programmer’s editor based on Matt Dillon’s DME. XES gives you
the ability to use XDME for much more than just programming. It lets you
easily use it for outlining and word processing, and it makes it easier to
program in specific languages, such as C, by formatting your code properly.
XES is the new name for XDMD, which stood for "XDME Macros by Duniho." I
changed the name, because I want to encourage other people to contribute to
it. XES is the successor to DMD, which was released for the last time a
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couple years ago. XES picks up the version numbering from XDME.

1.3 Editing

Regions
Rectangles
Clipfiles
Clipboard
Blocks

1.4 Requirements

All you need to begin using XES is XDME. This version is designed
for XDME 1.84. If you have an earlier version, some of XES’s features will
not work. You can ftp the latest version of XDME from ftp.fh-konstanz.de
in pub/amiga/. Since XDME requires WB 2.04, so does XES.

To make full use of XES’s features, you should also have the
following:

I. ARexx (for the ARexx scripts)
IT. GadToolsBox.library and NoFrag.library (for the GTB requesters)
IIT. RexxArpLibrary.library and ARP.library (for some of the ARexx
scripts)
Iv. RexxReqTools.library and ReqgTools.library (for Reqgtools

requesters and for some ARexx scripts)

V. XPKMaster.library, xPack, and various compressor libraries (for
the ability to decrypt and load encrypted files, and for the
ability to pack or encrypt files when saving)

I also recommend using xData with XDME. This will let XDME read
XPK-packed files. I didn’t incorporate this ability into XES, because
xData does it more efficiently. You should already have ARexx, and you
should be able to find the rest on the Aminet or on a local BBS.

1.5 Regions
A region is the text between the mark and the point. Each window
has its own mark and point. The mark is a location you set with c-@ or with

c-spc. The point is the location of the cursor in an active window. The
region begins at whichever comes first, the point or the mark, and it ends
just before whichever comes last. There are various commands for editing
regions. These are mapped to the same key combinations as are similar
commands in Emacs. I took the idea of editing regions straight from Emacs.

Here are the keymappings for editing regions:




XES

3/14

c-w kills a region. It copies a region to the clipboard and
deletes it.

a-w copies a region to the clipboard.

c-y yanks the contents of the clipboard. It inserts the
clipboard’s contents and marks it as a region.

Unlike Emacs, XES does not maintain a killring. It just puts the
contents of a region into the clipboard. To understand regions better, I
refer you to the documentation for GNU Emacs.

Please note that c-w and a-w set the blocktype to character and
leave it that way.

1.6 Region Rectangles

A region rectangle is another concept from Emacs. It is like a
region, but the mark and point mark the the corners of a box. There are
various things that you can do with rectangles. You can delete them, clear
them, or push them to the right. The commands which operate on vertical
blocks treat them as rectangles. Since rectangles cannot be inserted like
regular text, they are not stored in the clipboard. The cut and copy
facilities, which are mapped to Right Amiga X and to Right Amiga C, copy
vertical blocks to T:rectangle. You can insert rectangles with the "Yank
Rectangle" subitem in the "Insertion" submenu of the "Edit" menu.

1.7 Clipfiles

Clipfiles were originally implemented in XDME as a substitute for
real clipboard support. A clipfile is a file that you can save text to and
insert text from as though you were cutting and pasting with the clipboard.
Although XDME now has genuine clipboard support, I have reasons for using
clipfiles as well. One advantage of clipfiles is that you can append text
to them, whereas XDME has no command for appending text to the clipboard.

Furthermore, I have drawn on the Emacs concept of a register to
make clipfiles even more useful. In Emacs you can copy text to registers
instead of putting it on the killring. This allows for easy retrieval of
the text in case you kill more text in the meantime. With XES, you can
change the file used as a clipfile. You can also change it back to what it
once was, so that you can copy text to a clipfile and keep it around until
you need it.

Nevertheless, using clipfiles has at least a couple disadvantages
over using the clipboard. One is that the commands for copying text to
clipfiles currently work only with line blocks. The other is that other
programs can’t use them as easily as they use the clipboard.

The clipfile commands are mapped like the clipboard commands,
except they use the left Amiga key instead of the right. They are A-c for
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copying, A-x for cutting, A-v for pasting, and A-a for appending.

1.8 5.

Major Modes
XPK support
#?.xsrc files
Diary
Pagination
Insert Literal
GTB Requesters
Spell Checking

1.9 Major Modes

XES provides XDME with many major modes. I took the concept of
major modes from GNU Emacs. A major mode is a configuration of keymappings
that makes editing a particular sort of document easier. The major modes in
XES are completely localized. This means that when you set a major mode, it
is only for the window you set it in. So, for instance, you can have C mode
in one window and Text mode in another, and you can switch back and forth
between them without manually switching modes.

Usually, you will not have to set a major mode. If you load files
with the AppIcon or with the requesters I mentioned in the previous section,
XES will set the mode for you automatically. It will do this for you in one
of two ways. If the file has an accompanying "#7?.xsrc" file, XES will use the
mode named in that file. Otherwise, it will choose a mode based on the name
of the file. For example, files ending in "#7?.c" will be loaded in C mode.

1.10 XPK Support

XES provides XDME with partial XPK support. It doesn’t provide
complete XPK support, because I use XDME with xData. This program lets you
load XPK files into other programs, and I highly recommend getting it. XES
provides XDME with what xData doesn’t. With XES you can pack files every
time you save them, and you can encrypt and decrypt files as you save and
load them.

To pack or encrypt a file, you have to select an XPK method other
than NONE, which is the default. You may select the method with the
"Select Method" subitem in the XPK submenu in the Misc menu. This will pop
up a file requester for the LIBS:Compressors directory, which is where all
your XPK compressor libraries should be stored. Select the library you
want, and that library will be used to pack or encrypt the file you
selected it for everytime you save that file.

You should bear in mind that this requester will let you select an
XPK method for one window only. So you can work on a file you want
encrypted in one window, and a file you want left unpacked in another. 1If
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you want to encrypt a file, you should also select a password for the
encryption. You may do this with the "Select Password" subitem in the XPK
submenu. This password will apply only to the window you selected it for.

So that a file will be packed or encrypted whenever you save it,
you must use the "Save As" requester mapped to c—-x c—-w or the "Save"
subitem in the "Save" submenu. The keyboard shortcut for this is Right
Amiga S, and it is also mapped to c-x c-s.

The ARexx script responsible for loading files checks whether a
file was encrypted with FEAL or with IDEA before loading it. If the file
was so encrypted, the script will pop up a password requester. If you get
the password right, it will successfully decrypt the file before loading it
into XDME. Otherwise, it will load the file in its encrypted form.

XES does all packing, encrypting, and decrypting of files with the
"xpack" program, which comes with the XPK package. It writes temporary
files to T:, uses xpack on these files, and then loads the file into XDME or
moves it to the place you want to store it.

1.11 #?.xsrc files

An "#?.xsrc" file which XES sources whenever you load its
accompanying file. It normally contains the major mode, the margins, and
settings for printing it with paginate. You may also put anything
else in an "#?.xsrc" file by editing it like an .edrc file.

To automatically create an "#7?.xsrc" file for a file, you should
select "Preferences" from the "Save" submenu in the "Project" menu.
Previously, XES automatically created these files for each file it saved.
I changed it because the automatic mode selection will suffice for setting
the parameters for most files.

To have an "#?.xsrc" file make a difference when you load a file,
you must use the AppIcon or one of the requesters XES supplies for loading
files.

1.12 5.4.

XES makes it easy for you to maintain a secret diary of your
private personal affairs. To make an entry in your diary, select the
"Diary" subitem in the "Load" submenu of the "Project" menu. This will
present you with a requester set to the directory that you keep your diary
in. The default filename will be the entry for that day, even if it doesn’t
exist yet. Each diary filename will be a date in sorted date form. This
will be an eight digit number with the year first, the month second, and the
day last. It is in sorted date form so that the file requester will show
the entries in order. To make an entry in your diary, Jjust press RETURN.

Before it loads a file or creates a new entry, it will ask you for
a password. If the entry you want to load already exists, it will use this
password to decrypt the entry. It will also use this password to encrypt it
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whenever you save it. The diary is set to use IDEA encryption with the
xpkIDEA.library.

Whenever you use the Diary requester to load a previous day’s
entry, it will load that entry in Read Only mode. This is to help keep your
diary faithful to what you originally wrote.

To use the Diary facility, you need XPK and in particular the
xpkIDEA.library. Before using it, you should edit Diary.xdme to print your
name, instead of my own, in each diary entry, and to choose the directory
you want to store your diary in.

1.13 5.5.

XES lets you easily paginate your files. It does this with the
help of my "Paginate" program. You may set the parameters for paginate by
selecting "Set Parameters" in the "Paginate" submenu of the "Format" menu.
To know how to set Paginate’s parameters, you should read "Paginate.man".
If you’re unhappy with the result, you can reload the original file as
T:Text and try again.

1.14 Insert Literal

XES provides you with three different ways to enter characters that
you can’t or don’t know how to type. The easiest way is to use the "Insert
Literal" requester. This shows a requester of all printable characters.
Just select the character you want with the mouse, and it will appear in the
text. This requester is available in the "Insertion" submenu of the "Edit"
menu, and its keyboard shortcut is Right Amiga L. To use this requester,
you must have RexxArpLib.library installed. This requester will use
whatever font you have selected for the window you are in.

The second way is with the "Insert ASCII" requester. This lets you
insert any character at all by entering its ASCII number. This may be
slightly quicker than the "Insert Literal" requester if you already know a
character’s ASCII value. But more importantly, it lets you insert any
non-printable character, such as a formfeed or an escape. This requester is
mapped to a-a. It is also available in the "Insertion" submenu

The third way is the way it’s done in Emacs. Type c—-g followed by
the key combination for the character you want.

1.15 GTB Requesters

XES provides XDME with 4 GadToolsBox requesters:

Find & Replace
Pen Colors
Printing
Margins
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Windows
Local Settings

1.16 Find & Replace GTB Requester

The Find & Replace requester is mapped to right Amiga r and
accessible as "Replace ..." in the Search-Replace submenu. It pops up an
asynchronous requester with two string gadgets and five buttons. You can
use the requester to search backwards and forwards for words, to do a
selective search and replace, or to replace every occurrence of a string
within either a block or the entire document. Replacing within a block works
accurately for every block type.

1.17 Pen Colors GTB Requester

The pens requesters shows six palettes, one for each pen that XDME
can set. Colors change as soon as you select a color on a palette. The
requester doesn’t go away until you click on the close gadget. So you can
just keep clicking on colors until you find a color combination that you like.
If you find a color combination you want to keep, you can save it by selecting
"Save Config" in the Settings menu.

1.18 The Print GTB Requester

The Print requester has many string and integer gadgets for
changing the parameters for Paginate, the program XES uses to print files
in XDME. Paginate is a pagination program I wrote myself and have included
with XES. You should read the manual for it to know more about it. I will
not repeat details about it here.

The Print requesters lets print to PRT:, preview what the file will
look like in its printed form, print it to a file, or append it to the end of
another file in paginated form. Please note that the margins you can set with
this requester are parameters only for Paginate. They are not XDME margins
or printer margins.

1.19 The Margins GTB Requester

This requester lets you set the indent column, the left margin, and
the right margin with slider gadgets. It does not let you make the left
margin greater than the right or the right less than the left. Whenever you
pop it up, it shows your current margins. It doesn’t let you set any margin
greater than 80. To do that, you should set it manually.

The indent column is useful mainly in text mode. It indicates how
much the first line of a paragraph should be indented. Outline mode also uses
it, but the outline commands calculate and set this value automatically.
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1.20 The Window GTB Requester

The Window requester lets you select a window to go to. Whenever
you use this requester to go to another window, it updates the menus, so that
the checkmarks indicate the correct values for the window you’re in. This
requester replaces the Windows menus from previous versions of XES. This
requester is not limited by the same restrictions as the menu was.

1.21 The Local Settings GTB Requester

Since local settings are different from window to window, the
checkmarks for them in the menus can sometimes be inaccurate. So I took
them out of the menus and put them into a requester. This requester keeps
track of Wordwrap, Viewmode, Insertmode, Autoindent, Autosplit, Ignorecase,
the XPK Password, and the XPK Method. It lets you select the XPK Method
from a listview. XES calls the ARexx script xMethods.xdme to generate the
list for this listview. It calls it only at startup.

1.22 Spell Checking

XES uses AlphaSpell for spell checking. It writes the contents of
the window to a temporary file and uses AlphaSpell to generate a list of
words that are not in the dictionary. It then loads this list into an array
and sets the numeric keypad to spell-checking mode. In spell-checking mode,
some of the keypad’s keys move you about in the list of unfound words:

7 moves to the start of the array.

1 moves to the end of the array.

- moves to the previous array member.
+ moves to the next array member.

Each of these keys also positions the cursor at the beginning of
the document to start a new search.

Some keys set the search string to the current array member and
display it in the title bar:

5 does just that and nothing more.
9 also searches backwards for it.
3 also searches forwards for it.

The remaining keys function as they do in the numeric keypad’s
movement mode. 2, 4, 6, and 8 function as cursor keys.

To spellcheck, select "Check Spelling" from the Spelling submenu in
the Misc menu. Use the numeric keypad to move through the list of unfound
words and to search for each one that may be a misspelling. Change the
spelling as you would edit any other mistake. You may use the find requesters
with spell-checking, as well. So, for instance, you could replace every
occurance of a misspelled word at once. But be careful, because XDME doesn’t
yvet have a whole word search mode.
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1.23 History

XDMD v1.00
XDMD v1.10

XES
XES
XES
XES

v1.20
v1.25
v1.30
v1.31

1.24 XDMD v1.00

Released 29 October 1994

1.25 XDMD v1.10

Released 29 October 1994

IT.

IIT.

Iv.

G.

A.

By taking a short detour through ARexx, I implemented arrays in
XDME. The macros "set-array," "get—array," "free-array,"
"unset-array," and "unset-member" all work with arrays. The
ARexx script LoadArray loads a file into an array.

I used the array capability to redo how spell-checking works in
XDME. 1Instead of using a requester, it uses LoadArray to put
the list of unfound words into an array. It then redefines some
keys on the numeric keypad.

nkl goes to the last word in the array.

nk7 goes to the first word in the array.

nk+ moves forward through the array.

nk— moves backwards through the array.

nk2, nk4, nk6, and nk8 work as cursor keys.

nk3 and nk9 search forwards and backwards for the find
string, which gets set to the current word in the array
whenever you move through the array.

nk ( puts the numeric keypad back in number mode.

Yesterday, before I figured out how to implement arrays, I did

some new spell-checking routines with twin variable stacks. I
left the code in .edrc for anyone interested in looking at it.

I added the "empty-stack" macro, because "purgevar" doesn’t
work.
I fixed some bugs in s-bs and s-del. I added a-d, which works

like M-d in Emacs.
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VI.

A.

I added the "delstr" macro.

I reset toggle 0 and set toggle 1, so that I can use variables
as flags with "if," "ifelse," and "while."

I added some numeric keypad modes.

A.

B.

"keypad-numbers" - your ordinary numeric keypad

"keypad-move" - the cursor movements written on the front.
nk5 recenters the screen.

"keypad-spell" - the mode for spell checking, which I
described earlier.

1.26 XES v1.20

Released 9 November 1994

IT.

ITT.

Overhauled the menus.

A.

New

New

Checkmarks indicate whether different settings are set.
These get updated for whichever window you are in if you
change windows with the menu.

Amiga key symbols have replaced "A-"s.

The menus have been rearranged somewhat.

macros:

"Intcmp" macro compares two numbers. With its help, nk+
and nk- never take you out of bounds when spell-checking.

"Prev2" macro serches backwards for the closest of two
different strings.

"Prevf" macro searches backwards for a string, and it sets
a flag if the search fails.

"Pos" takes a column and line number as arguments and goes
there.

"Pos—-1line" indents the current line n columns from the
left.

"Text-format" formats a paragraph according to values
stored in $indcol and $parcol. $Indcol indicates how much
the first line of a paragraph should be indented. The
outlining macros set these values and use text-format.

"Setindcol" sets the value of $indcol.

major modes:
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1.27

Iv.

Fundamental - What used to be called "Programming."

Programming - The tab key indents code in a general way
that is helpful for programming in any language. Use a
more specific mode if one is available for the language you
are programming in.

ARexx — The tab key properly indents ARexx code so long as
the strings "do" and "select" are not parts of longer

strings in the code.

Manual - For writing manuals.

Miscellaneous changes here and there.

XES v1.25

Released 17 November 1994

I. An asynchronous gadtools find and replace requester.
IT. More Emacs and Quasi-Emacs keymappings.

A. Registers sort of like in Emacs.

B. Many keymappings converted to equivalent in Emacs. For
example, "Save As" 1is now mapped to c-x c-w instead of to
f9.

C. C-g works like it does in Emacs. After pressing c-g, you
can type any character. C-x k is now the key combination
for closing a window.

D. The case conversion macros now work like the equivalent in
Emacs, and they have the same keymappings.

E. Major modes can easily be chosen with a c-x m <key>
combination.

F. Rectangle operations now have the same keymappings as they

ITT.

Iv.

VI.

VII.

have in Emacs. Those which have no keymappings in Emacs
are also mapped to a c—-x r <key> combination.

#?.xsrc files for each file saved. These are files that XDME
sources for an individual file after it loads it.

The right and left Amiga keys are recognized as different.
Clipfiles.
The AppIcon can be turned on and off from the Settings menu.

Automatic recognition of files encrypted with xpkIDEA.library
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or with xpkFEAL.library.

1.28 XES v1.30

Released 6 December 1994

I. More GadToolsBox requesters: Pens, Print, Margins, and Windows.
The Windows requester replaces the Windows menu.

IT. A new "block-type?" macro. This one reads S$block and even
tells whether there is a block. Editing commands no longer
require the cursor to be in the block to recognize that there
is a block.

ITTI. Paginate updated. The new version indents the text body at the
same column as it does the footers and headers. I have not
updated the documentation for it.

Iv. Shortlines added to Settings menu. This is like my Smartkeys
mode, but it is currently exhibiting some unwanted behavior.
So I put Smartkeys back in.

1.29 XES 1.31

Released 23 December 1994

I. Various macros updated to work with shortlines mode, now that
it is working right. I changed "right" to "col +1" in various
places.

IT. A new GTB requester for local settings. This replaces the
items that were regularly updated in the menus. This saves
time when switching between windows. This requester also keeps
track of your XPK password and method. It lets you select a
method from a listview gadget that contains all available XPK
compressors.

IIT. Bug fix: Copy and Cut in the Edit menu now work correctly.

1.30 Features

Here are some of XES’s features:

I. Outlining
IT. Localized major modes
A. Text mode

B. Two C modes, ANSI and K&R, complete with automatic line
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indentation.
C. A general programming mode for other languages.
D. An outline mode for writing outlines, like this one.
E. A proofs mode for writing logical proofs. (I’'m a philosophy
major.)
IIT. Automatic major mode selection upon loading.
Iv. The maintenance of a "Windows" menu that keeps track of all of

XDME’ s windows.

V. Different styles of editing integrated with each other.
A. Cutting and copying for all block types.
B. Regions and rectangles, ala Emacs.
VI. XPK support, including automatic packing or encryption upon

saving, and decryption with a password requester.

VII. The maintenance of a personal diary, complete with password
encryption and decryption.

VIIT. Spellchecking via the AlphaSpell program and its accompanying
dictionary.
IX. Automatic pagination via the Paginate program.
X. Various find and replace routines, including a Find requester
and a Replace requester. The Replace requester lets you

replace the word at the cursor, every occurance of the find
string in the text, or every occurance in a block.

XI. Various Emacs like keymappings.

1.31 Installation

To install XES, click on the install icon. This will copy files to
your S:, REXX:, and C: drawers. If you don’t want something overwritten,
such as your current .edrc file, back it up first.

Copy the dictionary to your harddrive, to a high density disk, or
to a double sided diskspare disk. It is too large for a normal Amiga
double sided disk. Change the value of $Dict in ".edrc" and the values of
path and name in "Diary.xdme" to suit your own needs.

1.32 Copyright
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The dictionary is public domain. Everything else in the archive is
copyright © 1994 by Fergus Duniho. XES is freeware.

1.33 Distributability

You may freely distribute this archive so long as you leave it
unchanged and make no profit from its distribution. Sale of XES is
strictly prohibited.

1.34 Disclaimer

There is no guarantee that XES will do anything you want it to. I
am not responsible for any damage that results from using XES. You use it
entirely at your own risk.

1.35 About the Author

I am Fergus Duniho. I am also the author of the DDLI, a
computerized personality indicator. Get ddli341l.lha from the aminet and
try it out.

My email addresses are:
Internet: fdnh@troi.cc.rochester.edu
Fidonet : Fergus Duniho @ 1:2613/278




	XES
	XES v1.31
	Introduction
	Editing
	Requirements
	Regions
	Region Rectangles
	Clipfiles
	5.
	Major Modes
	XPK Support
	#?.xsrc files
	5.4.
	5.5.
	Insert Literal
	GTB Requesters
	Find & Replace GTB Requester
	Pen Colors GTB Requester
	The Print GTB Requester
	The Margins GTB Requester
	The Window GTB Requester
	The Local Settings GTB Requester
	Spell Checking
	History
	XDMD v1.00
	XDMD v1.10
	XES v1.20
	XES v1.25
	XES v1.30
	XES 1.31
	Features
	Installation
	Copyright
	Distributability
	Disclaimer
	About the Author


